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1. Rule Editor Overview 

The NY-DEx Security Rule Editor is a desktop application that allows an 
agency to define authorization levels for their agency’s incident data.  
When the NY-DEx batch process executes, it retrieves incident records 
from the agency's Records Management System (RMS).  Before this data 
is submitted to DCJS and the FBI, the security rules defined using the NY-
DEx Security Rule Editor are applied to these records.  These records are 
given one of three authorization flags: 

 GREEN - This flag is the default flag. This means all NY-DEx and N-DEx 
users will be able to see all of the data found within this record. 

 YELLOW - This flag is used to restrict NY-DEx and N-DEx users outside 
of the owning agency to only the incident number and contact information 
of the incident.  Users of the owning agency can view all of the incident's 
data. 

 RED - This flag is used to restrict all NY-DEx and N-DEx users outside of 
the owning agency from seeing the incident.  Users from the owning 
agency can view all of the incident's data.  Red incidents are submitted 
because they can be used for subscriptions within the N-DEx system. 

Once the authorization flags are set, the incidents are submitted to DCJS 
and the FBI. 



 

2. Main Options 

On the “Main” tab on the Options Pane, there are two options. 

 
 

Change Password - This screen allows the user to change your 
password 

Display Action Buttons at the Bottom of the Screen - If this option is 
selected, three command buttons will be displayed on the search screen:  
New Rule, Edit Rule and Delete Rule.  These commands are also 
accessible through the menu bar.  Any change will take affect when the 
application is restarted.   



 

The search screen with the buttons is displayed below. 

 
 



The search screen without the buttons is below. 

  



 

3. Options 

To open the Options pane, click Tools, Options on the menu bar. 

 
 

This pane will have one or two tabs.  All users of this system will have the Main tab 
available to them.  Only administrators will have access to the Users tab.  For details on 
these tabs, please read subsequent sections. 

 
 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/MainOptions.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/MainOptions.html
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4. Users Tab 

This tab is viewable to Rule Editor Administrators.  This tab displays a 
table that lists each person that can use the Rule Editor in the agency.  
The table contains columns for username, first name, last name, and an 
administrator indicator.   

This tab also has three command buttons:  New User allows the creation 
of a new user.  Edit allows the administrator to edit the selected user, and 
Delete provides an administrator with the ability to delete a selected user. 

 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/CreatingNewUsers.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/EditUser.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/DeleteUser.html


 

5. What are Rules? 

Rules are user defined incident criteria that are used to set flags of 
incidents.  If an incident matches the criteria of a YELLOW rule, it will be 
set to YELLOW.  If an incident does not fall under any rule, it will be set to 
GREEN.  There are four main types of rules that can be created. 

 Unified Crime Reporting (UCR) Code - These type of rules are 
created by using one of the standard 50 UCR codes.   

 Incident Type - These rules are created by using the Incident 
Categories and Incident Types found within an agency’s Records 
Management System (RMS). 

 Law - These rules are rules created using Law Titles, Sections and 
Subsections found within the NYS coded law table and cannot be 
created using an ordinal number.  

 Incident Number - A rule can be set using a specific incident 
number.  In this case, none of the data associated with the 
specified incident number will be transmitted to NY-DEx.   

These four rule types are mutually exclusive.  For example, a rule cannot 
use a UCR code and a Law code.  In conjunction with the UCR code, 
Incident Type and Law, two criteria that can be used to further refine a rule 
are: 

 Stereotypes:  These are user-defined person types that may be 
found within an incident.  See the Stereotype for additional 
information. 

 Incident Status:  These are the incident statuses defined in your 
RMS.  

For the following examples, there are no other rules in the system except 
for Rules 1 and 2, shown below.    

Rule number 1 shows that all incidents with the UCR Code 1 – MURDER 
should, by default, have a flag of YELLOW.    

Rule number 2 shows that all incidents with the UCR Code 1 – MURDER 
and a child witness should have a flag of RED. 



 

Rule 1 

UCR Code 1 - Murder 

Stereotype Not 
Applicable 

Status All Statuses 

Flag Yellow 

 

Rule 2 

UCR Code 1 - Murder 

Stereotype Child Witness 

Status All Statuses 

Flag RED 

 

To continue with the example, suppose the RMS has three incidents that 
are to be processed.  These incidents are below, Incident numbers 18, 19 
and 20. 

Incident number 18 will be YELLOW because it has a UCR Code of 1 – 
MURDER, matching Rule 1.  

Incident 19 is RED because it has a UCR Code of 1 – MURDER and has 
a child witness named Timmy O'Toole, which matches Rule 2.  

Incident number 20 does not match either of the existing rules and 
defaults to GREEN. 



 

Incident number 18 

UCR 
Code 

1 - Murder 

Witness Drew Carey, 
Age 53 

Resulting 
Flag 

Yellow 

 

Incident number 19 

UCR 
Code 

1 - Murder 

Witness Timmy O’Toole, 
Age 12 

Resulting 
Flag 

Red 

 

Incident number 20 

UCR 
Code 

10 - Arson 

Witness Jerry Yaeger, 
Age 18 

Resulting 
Flag 

GREEN 

 

All incidents that do not match any rules are set to GREEN.  The default 
flag color cannot be changed from GREEN.  



 

a. Rules Order of Precedence 

Many incidents will match the criteria of more than one rule. In this case, 
there must be a way for the NY-DEx batch system to determine which rule 
to apply. This is determined by the security rule order of precedence. This 
order of precedence is described below. The stronger rule type is placed 
on top (#1 the strongest). This order cannot be configured by the user.  

1. Incident Number rules - When an Incident Number rule is created, no 
other rule can override it.   The next time the NY-DEx batch system 
executes, the incident will be resubmitted to DCJS and to the FBI.  
This is not the case with any other rule type. 

2. Stereotype Override Flags - When a Stereotype is created, a default 
flag is set.  If the Default Flag Override option within the Stereotype 
creation screen is set to “Yes”, then this flag is the second most 
powerful rule in the system.  These should be used when your agency 
has a strong sealing policy on a particular type of person. 

3. UCR Code  

4. Incident Category and Type  

5. Law 

6. Stereotype Defaults - If a Stereotype's default flag does not override 
other rules, these default flags are applied. 

7. Incident Status Defaults - These are the weakest types of rules. 

UCR, Incident Type and Law Type rules may or may not be associated 
with a Stereotype.  If there are two rules with the same UCR code, 
Incident Type or Law Type, but one has a Stereotype and one does not, 
the rule with the Stereotype overrides the rule without the Stereotype 
when that particular Stereotype is found within an incident.  

Another example, if an incident has PL 140.05 and PL 210.02 as laws, 
and PL 140.05 is RED and PL 210.02 is YELLOW, this incident will be set 
to RED. 



 

6. What is an Incident Status? 

Every incident has an Incident Status.  Typically, this indicates whether an 
incident is open or closed.  There are several ways that agencies describe 
open or closed.  These statuses are defined within your RMS.   

Incident Status is used in two places within the Rule Editor.  Every rule 
created has an associated status.  Users can also create status default 
flags.  These defaults mean that when no rules apply to an incident, this 
flag is applied depending on the incident status.  

Example 

For this example, there are only three rules and only three incident 
statuses in the system.   

Incident numbers 30, 31 and 32 follow rules 1, 2 and 3, respectively.   

Incident numbers 33, 34, 35 are set by the incident status defaults 
because there are no Disorderly Conduct rules defined.   

Take special note of incidents 31 and 34.  The GREEN Rule 2 overrides 
the RED Status Default of “Closed by DA”.  The GREEN rule can override 
RED or YELLOW rules, depending on the order of precedence.  See the 
Rule Order of Precedence section for more details. 

Rule 1 
UCR Code 10 – ARSON 

Stereotype Not Applicable 

Status Open 

Flag YELLOW 

 

Incident 30 
UCR Code 10 – ARSON 

Status Open 

Flag YELLOW 

 

http://www.criminaljustice.ny.gov/Data/DCJS/OJIS/ED/AllShared/migdoc/PROJECTS/NY-DEx/Rule%20Editor%20-%20HTML%20Help%20Files/help/RuleOrderOfPrecedence.html


Rule 2 
UCR Code 10 – ARSON 

Stereotype Not Applicable 

Status Closed by DA 

Flag GREEN 

 

Incident 31 
UCR Code 10 – ARSON 

Status Closed by DA 

Flag GREEN 

 

Rule 3 
UCR Code 10 – ARSON 

Stereotype Not Applicable 

Status Offender Dead 

Flag RED 

 

Incident 32 
UCR Code 10 – ARSON 

Status Offender Dead 

Flag RED 

 

Status Defaults 
Open GREEN 

Closed by DA RED 

Offender Dead GREEN 

 



 

Incident 33 
UCR Code 45 – DISORDERLY 

CONDUCT  
Status Open 

Flag GREEN 

 

Incident 34 
UCR Code 45 – DISORDERLY 

CONDUCT  
Status Closed by DA 

Flag RED 

 

Incident 35 
UCR Code 45 – DISORDERLY 

CONDUCT  
Status OFFENDER DEAD 

Flag GREEN 

 

Incident #35 

UCR Code 45 – DISORDERLY CONDUCT 

Status 
 

Flag GREEN 



a. Incident Status Defaults 

To open the Incident Status Defaults section of the application, click 
Tools, Status Defaults on the menu bar and the Status Defaults screen 
will display.   

 

 

When the radio button “Disable Status Defaults” is selected, the table is 
disabled.   Incidents will not be assigned security flags based on incident 
status alone (remember that this is the weakest rule type).  

 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/RuleOrderOfPrecedence.html


When the “Enable Status Defaults” radio button is selected, the Security 
Flag table will become enabled.  This table allows the user to set a 
security level for any and all incident statuses.  Click the Security Flag field 
located next to the Incident Status that needs to have a security flag set.  
Remember that incident status defaults are the weakest type of rule.  
These defaults will work only when no other rule / security flag is applied 
to a particular incident. 

 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/RuleOrderOfPrecedence.html


 

7. What are Stereotypes? 

The NY-DEx Rule Editor includes the ability to create ‘Stereotypes’.   
These are user-defined entities that describe a type of person that can be 
found in an Incident report.  Instead of binding person criteria to each rule, 
you will describe a type of person as a Stereotype. This Stereotype can 
then become a single criterion on the rule.  A stereotype can be created 
using the following attributes: 

 Title - This is the identifier for the Stereotype.  Examples: Child 
Witness, Adult Woman 

 Person Type - This is the type of person that the Stereotype 
represents.  These are the same person types within an agency's 
RMS.  Examples are Witness or Victim.  This can be set to Not 
Relevant, also, so that the Stereotype will apply to all Person 
Types. 

 Sex - This is the gender of the Stereotype. 

 Age - An age range can be set for a Stereotype or a specific age of 
the person can be used. 

 Injury Type - This is the injury suffered when the incident occurred. 

 Religion - This is the religion of the Stereotype. 

 Ethnicity - This is the ethnicity of the Stereotype. 

 Race - This is the race of the Stereotype. 

 Default Flag - This is the flag that will be assigned to an incident if 
this Stereotype is found within the incident and no other rules have 
been applied.  GREEN is recommended. 

 Default Flag Overrides Other Rules - No matter what rules exist, 
if this Stereotype is found, the Stereotype Default Flag is applied.  
This option is not recommended unless your agency has a strict 
sealing policy on a certain type of person.  

 

Examples: 

In the first example, there are two Stereotypes, two rules and four 
incidents in the system.   



UCR Code 47 – LOITERING is not listed under any rule so it should 
default to GREEN.  

However, incident 23 is set to RED because it contains a child witness 
(Timmy O'Toole). Child witnesses default to RED and overrides other 
rules.  If Timmy O'Toole was not a witness, it would be GREEN. This is 
exemplified by incident number 25, which is GREEN.  

 

2 Stereotypes:   

Title Child Witness 

Person 
Type 

Witness 

Age <18 

Default Flag RED 

Override YES 

 

Title Adult Woman 

Person 
Type 

Victim 

Sex Female 

Age >18 

Default Flag GREEN 

Override NO 

 

2 Rules: 

Rule 1 

UCR Code 1 - Murder 

Stereotype Not Applicable 

Flag YELLOW 

 



 

Rule 2 

UCR Code 22 – Sex Offense 

Stereotype Adult Woman 

Flag RED 

 

4 Incidents: 

Incident number 23 

UCR Code 47 - Loitering 

Witness Timmy O’Toole, 
Age 12 

Resulting 
Flag 

RED 

 

Incident number 24 

UCR Code 1 - Murder 

Victim  Kate Williams,  
Age 19 

Resulting 
Flag 

YELLOW 

 

Incident number 25 

UCR Code 47 - Loitering 

Victim  Martha Anderson 

Resulting 
Flag 

GREEN 

 

Incident number 26 

UCR Code 22 – Sex Offense 

Victim  Linda Burke, 
Age 34 

Resulting 
Flag 

RED 

 



Incident number 24 will be YELLOW because Rule 1 sets murders to 
YELLOW.  Kate Williams has no affect on this incident's flag.  

Incident number 25 will be GREEN because it is not restricted according 
to Rule 1 or Rule 2. 

Incident number 26 will be RED because Rule 2 requires that UCR Code 
22 - SEX OFFENCE incidents with adult women are set to RED.  If the 
Victim of this incident was not an adult woman, it would be set to GREEN. 



 

a. Stereotype Browser 

The Stereotype Browser is a dialog window that allows you to view the 
attributes of each Stereotype in your system. To open the Stereotype 
Browser, click Tools > Stereotypes on the menu bar. 

 
 

 

Once a menu option is selected, the Stereotype Browser will be displayed.  
The Stereotype Browser has a select box on the top, a Stereotype 
description table, and four command buttons (includes Close).  The drop 
down box lists all of the Stereotypes in your system. When you select a 
Stereotype, its attributes will be displayed in the table below it.  

 



 
 

The New button will allow the creation of a new Stereotype.  Edit allows 
the editing of a selected Stereotype and Delete will delete the current 
Stereotype, as well as delete each rule that contains that Stereotype. 



 

8. Creating a New User 

To create a new user, click the New User button on the Users Tab. This 
button will open the New User dialog, which is displayed below. 

 

Enter the following in the appropriate fields: 

o First Name - The first name of the user. 

o Last Name - The last name of the user.  First and last name are 
used only as a reference. 

o User Name – What the user will use to sign into the Rule Editor. 

o Administrator - This option indicates whether or not the user is an 
administrator.  Administrators can create, edit and delete other 
users, as well as export XML files. 

Click Save and a message will display indicating that the user's password 
is set to “pass”.  The user will need to change the password the next time 
logging into the  

Rule Editor.  

 



  

 

9. Creating New Security Rules 

Before creating a new rule, there are several conditions that will need to 
be verified by the person creating the new rule.   

1.  It will be necessary to know or to determine the agency's policies with 
regard to incident data sharing.  Rules that are entered into this system 
are active the moment the rules are created.  Make sure to discuss 
proposed rules with the supervisor or whoever makes the decisions on 
what data is to be shared (or not shared).  

2.  It is, also, important to ensure the rule about to be created does not 
already exist in the system.  To verify if a rule exists, look at the Rule 
Search Screen, the main screen that is displayed after signing into the 
Rule Editor application.  

3.  Determine if the rule is really a rule.  For example, if a rule is created 
for every UCR Code, to set OPEN incidents to YELLOW, a new rule is not 
needed.  Instead, enable status defaults and set OPEN to YELLOW. 

After verifying steps 1, 2 and 3, there are two ways to create a rule.  1)  
Click File, New Rule, or 2) Click the “New Rule” button on the search 
screen.  This button is only available if the “Display Action Buttons at the 
Bottom of the Screen” under Tools > Options has been selected.  

 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/SearchingForRules.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/SearchingForRules.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/MainOptions.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/MainOptions.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/MainOptions.html


 
 

Once New Rule has been selected, the user is prompted to select a rule 
type.   The options are UCR Code, Incident Type, Law and Incident 
Numbers.  Select a rule type and click Next.  A screen specific to the Rule 
Type selected will appear so that additional data can be entered.   

 



 
 

Once a Rule Type is selected and a new rule is created, the rule type 
cannot be changed.  In order to change the rule type on any given rule, 
the rule would need to be deleted and recreated under another rule type. 

a. Creating New Rules for 
Incident Numbers 

The image below displays the screen to create a new rule for 
specific incident numbers.  This window is different from the other 
screens used to create rules, in that multiple rules can be created 
by entering up to 64 incident numbers at one time. Note that 
there is only one security flag selection on this window.   Incident 
Number rules do not take Stereotype or Incident Status into 
consideration. 

In the screen below, 15 incident numbers have been entered.  
When the user clicks on Save, the 15 new rules are created.  
These incidents have been set to RED.   Also, when saved, a 
message is sent to the NY-DEx batch process indicating that 
these 15 incidents need to be resubmitted.  The resubmission will 
occur during the next scheduled run and is unique to incident 
number rules. 



 
 

Errors 
You may get the error below after clicking on the Save button.  
This error is the result of not pressing the Enter or Tab keys, 
after typing the incident number.  If a cell is displayed with a red 
border, the data within the cell is invalid. 

 

 



 
 

b. Creating an Incident Type Rule 

The screen below is used to create a new Incident Type rule.   

Incident Category:   From the drop down, the user will select an incident 
category.  These categories are in alphabetical order.  Once a Category is 
selected, the Incident Type select box will be populated. 

Incident Type:   By default, this select box will have “ALL” selected.  This 
indicates that this rule will serve as the default rule for the selected 
category.  The user can change the default by clicking on the drop down 
and selecting an incident type. 

Stereotype and Status Table:  See the create UCR Rule section. 

c.   Creating a New Law Rule 

The screen below displays the fields required to create a new Law Type 
rule.   

file://nysdcjs/public/data/DCJS/OJIS/ED/AllShared/migdoc/PROJECTS/NY-DEx/Rule%20Editor%20-%20HTML%20Help%20Files/help/CreatingUCRRule.html


The Law Table and its three filters work the same way as the Law Search 
Pane. To create a Law Type rule, the user selects the Law Title from the 
drop down, then the section and subsection.  

Once the Title, Section and Subsection have been selected, the user can 
further restrict the incident data by assigning an authorization level to any 
or all of the incident statuses.  

 

 

file://nysdcjs/public/data/DCJS/OJIS/ED/AllShared/migdoc/PROJECTS/NY-DEx/Rule%20Editor%20-%20HTML%20Help%20Files/help/SearchingByLawType.html
file://nysdcjs/public/data/DCJS/OJIS/ED/AllShared/migdoc/PROJECTS/NY-DEx/Rule%20Editor%20-%20HTML%20Help%20Files/help/SearchingByLawType.html


 

Examples  

In the example below, the Law Title and section of PL/125.15 is selected. 
This rule will be applied to any incident with the Law Title PL and the 
Section 125.15, regardless of the subsection, and will override any rule 
that was created with only the Law Title selected (PL).  

 

 

 

In this next example, the Law title of PL was selected, along with the 
Section of 125.15 and the subsection of 00H. This rule will be applied to 
any incident with the Law Title PL, the section 125.15 and the Subsection 
00H and will override any rule that was created with the Law Title and 
Section selected.  

 

 



 

d. Creating a UCR Rule 

Below displays the New UCR Rule screen and the fields needed to create 
a UCR Rule.  

 
 

To begin, the user will select a UCR Code from the drop down box.  
Currently, 26 – PROSTITUTION is selected. 

The Stereotype drop down is an optional field.  If a Stereotype is not 
applicable, select “Use this rule as a default”.  

The Incident Status table allows the user to designate a security flag for 
the UCR Code rule, based on incident status.  The example shows an 
Incident Status of OPEN set to YELLOW, as well as a status of CLOSED 
– PROSECUTION DECLINED being set to RED.  The remaining statuses 
are set to GREEN.   



The buttons on the left hand side change all of the flags to their respective 
colors. The red “X” changes all the flags to RED. The yellow circle symbol 
will change the selected statuses to YELLOW and the green check 
changes the selected statuses to GREEN.  After clicking one of these 
buttons, it is still possible to change the status of any of the other flags. 

 

When finished making changes to the incident statuses, click Save to 
save the rule, or Cancel to cancel the rule creation. 

If the rule has been successfully saved, the message below will be 
displayed. 

 
 

If a user receives the message below, it is an indication that the same 
rule, with the same UCR Code, Stereotype and Incident status 
combination already exists on the system.  The user will need to restart 
the creation of a rule. 

 



 

10. Creating Stereotypes 

To create a new Stereotype, click the New button on the Stereotype 
Browser and the New Stereotype dialog is displayed.  An image of this 
window is below. 

 
 



ID - System generated number for the Stereotype. 

Title - This is the name of the Stereotype.  

Person Type - This is one of the Person Types found in the RMS.  This 
will match the Stereotype to a Person Type found in an incident.  If Person 
Type is not relevant, select “Not Relevant”. 

Sex - The gender of the Stereotype. 

Age - The minimum and maximum age of the Stereotype.  If there is no 
minimum or maximum for the Stereotype, leave one of the fields blank.  In 
this example, the Stereotype has a minimum age of 22.  There is no 
maximum age.  The age fields are not required. 

Injury Type - The injury induced by the Stereotype during the incident. 

Religion - The religion of the Stereotype. 

Ethnicity - The ethnicity of the Stereotype. 

Race - The race of the Stereotype. 

Default Flag - When an incident does not match any rule, the default flag 
will be applied when this Stereotype is found in the Incident. GREEN is 
recommended. 

Default Flag Overrides Other Rules - When this option is applied to a 
Stereotype, all incidents that contain this Stereotype will have the 
Stereotype's default flag applied to the incident.  

To save a Stereotype, click the Save button.  Once a Stereotype is saved, 
it can be used in rules immediately.  



 

11. Editing a User 

To edit a user, select a user in the table and click Edit.  The Edit User 
screen will display.  This screen is the same screen used when adding a 
user, except that it does not set the user's password to “pass”. 

12. Editing Rules 

There are three steps in editing a rule. They are described below: 

1. Find the Rule - Using the rule search screen, select the rule to edit. 

2. Select the Rule - Click the rule in the table. 

3. Open the Edit Dialog - There are four different ways to open a rule.  

a. Double click on the rule. 

b. Right click the rule and select Edit Rule. 

 

c. Click the “Edit Rule” button.  (This is available only when the 
“Show Buttons” option is selected.)  

 

d. Or, click File, Edit Rule on the menu bar. 

 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/SearchingForRules.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/MainOptions.html


Once a UCR, Incident Type or Law Type rule is opened, the same 
screens used to create the rule types will display.  The difference is that 
the fields will be populated with the values of the created rule.  An 
exception, however, is an Incident Number Rule.  The edit dialog for 
Incident Number Rules allows you to edit only one rule at a time.  Also, 
only the security flag can be changed; not the incident number. 

 

 
 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/CreatingUCRRule.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/CreatingIncidentTypeRule.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/CreatingLawRule.html


 

13. Editing Stereotypes 

To edit a Stereotype, select a Stereotype in the Stereotype Browser and 
click the “Edit” button. The Edit Stereotype dialog will open with the 
selected Stereotype.   

 
 



 

14. Delete a User 

To delete a user, select the user to delete, and click the Delete button.  
The user will be removed from the user table. 

15. Deleting Rules 

There are four steps required to delete a rule: 

1. Find the Rule - Using the rule search screen, find the rule you want to 
delete.  

2. Select the Rule - Click on the rule you want to delete.  

3. Delete the Rule - There are three ways to delete a rule. 

a. Right click the rule and click Delete Rule. 

  

 

b. Click the Delete Rule button. This is only available if you 
enabled the “Show Buttons” option in the Option Pane. 

  

 

c. Click on File > Delete Rule in the menu bar. 

  

 



d. Confirm the delete by clicking on the “Yes” button to delete the 
rule.   

 
 

16. Delete Stereotype 

 

To delete a Stereotype, select a Stereotype on the Stereotype Browser 
and click Delete.  If no rules contain the selected Stereotype, the 
confirmation message below will display.   

 

If this Stereotype is to be deleted, click “Yes”. 

If there are rules that contain this Stereotype, the confirmation message 
below will display. 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/StereotypeBrowser.html


 
 

This message is confirming the Stereotype delete and the associated 
rules.   



 

17. Searching for Rules 

After logging into the NY-DEx Security Rule Editor, the two panes of the 
Rule Editor Search screen will display.  The bottom pane is a table of all 
the rules found within the system.  The top pane is a collection of filters 
that are used to filter the rules found in the system.  The two numbers on 
the status bar are the number of rules in the system and the number of 
rules displayed within the rule table.  

 

 



General Rule Filters 

On the left side of the search pane, there are five filters that apply to all 
types of rules.  These filters are described below: 

 
ID Number - This is the ID number of the rule, which is a system 
generated number.  To use this text field, type the number and press 
Enter. The rule table will be filtered using the provided number. 

Rule Type - This filters the table by rule type.  The options are UCR Code, 
Incident Type, Law and Incident Number.  This select box will also change 
the rule type specific filters pane on the right.   

Incident Status - This will filter the table by Incident Status.  This option is 
disabled when Incident Number is selected in the Rule Type selection box.  
Incident Number rules cannot use status as a criterion. 

Stereotype - This will filter the table by Stereotype and is disabled when 
Incident Number is selected in the Rule Type selection box. Incident 
Number rules cannot use Stereotype as a criterion. 

Security Flag – This filters by security flag and by default all flags are 
displayed. 



 

Menu Options 

To clear any filters, click File, Clear Filtering. 

 

To print the rules that are currently displayed in the rule table, click File, 
Print.  

To view Stereotypes or Incident Status Defaults, open their respective 
windows under the Tools menu.  For more details, read the Stereotypes 
Browser and Status Defaults sections. 

http://www.criminaljustice.ny.gov/xnysit/nysit/docs/StereotypeBrowser.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/StereotypeBrowser.html
http://www.criminaljustice.ny.gov/xnysit/nysit/docs/StatusDefaults.html


 

a. Searching by Incident Number  

When selecting an Incident Number Type in the Rule Type select box, the 
Incident Number filter is displayed.  When an incident number is typed and 
then “Enter” is pressed, the rule for that incident number is displayed (if it 
exists).  

 

 

 

b. Searching by Incident 
Category and Type 

When Incident Type is selected in the Rule Type field, the Incident Type 
filter pane is displayed. This allows the user to filter the rule table by 
Incident Category and Incident Type. By default, all Incident Type rules 
are displayed. Before selecting a type, the user must select a category. 
Typing a letter will jump the selection list to that letter.  

 
 



 

Once a category is selected, the rules are filtered by that category.  
Furthermore, the Incident Type filter is enabled.  This selection box will 
contain types that fall within the selected category.  For example, when 
the Murder category is selected, Justifiable Homicide, Murder and 
Negligent Manslaughter are available under the Incident Type filter.  Once 
an Incident Type is selected, only rules with that Incident Type are 
displayed in the rule table. 

 

 
 

c. Searching by Laws 

When the Law Type is selected in the Rule Type selection box, the Law 
Rule filter pane is displayed. This pane contains several fields, which are 
described below. 



 
Law Title - This drop down box filters the Law Table and the Rules Table 
by the selected Law Title.  These are the standard titles found within the 
NYS Coded Law Table. 

Keyword - This filters the Law Table by the typed word.  If the keyword is 
found within the Law Description, the law will be displayed within the Law 
Table.  To use this text box, type the word or phrase and press enter.  
This field does not filter the rule table. 

 
Section - This filters the Law Table with the typed Section number or 
code.  To use this text box, type the number or code and press enter. This 
field does not filter the rule table. 



 
Law Table  

This table lists laws that can be used to filter the rules below.  To filter the 
rules, select a row of the table.  

Some rows do not contain a Section or Subsection. See the example 
below. 



 

 

If a law is selected with a Section but no Subsection, all rules with the 
selected Title and Section are displayed.  All Subsections under that 
Section will also be displayed. 

 

 



When a law that contains a Title, Section and Subsection is selected, only 
rules with those three criterions are displayed. 

 

 

One anomaly with the Law Table is there are laws with the same Title and 

 

Sections, but with different descriptions, these are separate laws of 
different ordinals.  While NY-DEx does not support rules using ordinals, 
the dropdown will display each law for the purpose of using the law 
descriptions. 

 



 

 

d. Searching by UCR Code 

When the Rule Type select box is set to UCR Code, the UCR Code filter is 
displayed on the right side of the search pane.  This select box lists the 50 
UCR codes and their corresponding description.  Once a UCR Code is 
selected, the rules within the Rule Table will only display rules that apply 
to that UCR Code.  When the term “ALL” is used as a selection, all UCR 
Rules will be displayed. “ALL” is used repeatedly throughout the search 
pane and it implies “show all”. 



 
 

18. Export to Excel 

To export the rules that are visible within the rule search table, click Tools, 
Export, and then Excel on the main menu.  Select a file location and type 
a file name.  Do not provide a file extension (for example type “rules”, not 
“rules.xls” or “rules.csv”).  Click the Save button.  The system will create 
and save a comma separated value (CSV) file to the location requested.  
This file can be opened using MS Excel or Open Office.  

The Rule Editor cannot import from Excel, so this file should be treated as 
read-only. 

 


